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Chapter 446

Tests for Fold Change
of Two Means
Introduction
The fold change is the ratio of two values. It measures how much a variable has changed between the two
measurements. For example, suppose the beginning value of a variable is 2.5 and its value after a year has increased
to 5. This variable is had a two-fold increase in its value.
Fold changes are used when the change is of more interest than the absolute values. They are often used with
microarray data to measure the change in gene expression levels.
In this procedure, the fold change is the ratio of two means. By taking the logarithm of the data, the difference in the
means of the logged data corresponds to their ratio in the original scale. Thus, if we are willing to assume that the
logged data are normally distributed, we can use the two-sample t-test to perform hypothesis tests about the fold
change.
This procedure calculates power and sample size for t-tests from a parallel-groups design in which the logarithm of
the outcome is a continuous normal random variable.
The details of testing two treatments using data from a two-group design are given in another chapter, and they will
not be repeated here. If the logarithms of the responses can be assumed to follow a normal distribution, hypotheses
stated in terms of the fold change can be transformed into hypotheses about the difference. The details of this
analysis are given in Julious (2004). They will only be summarized here.

Testing of Fold Change
It will be convenient to adopt the following specialized notation for the discussion of these tests.
Parameter
μT

PASS Input/Output Interpretation
Not used
Treatment mean. This is the treatment mean.

μR

Not used

Reference mean. This is the reference (or control) mean.

FC

FC

Fold Change. This is the value of FC = μT / μR.

Note that the actual values of μT and μR are not needed. Only their ratio is needed for power and sample size
calculations.
In the two-sided case, the null hypothesis is H0: FC = FC0 and the alternative hypothesis is H1: FC = FC1 where
FC1 is not equal to FC0.
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Log-Transformation
In many cases, hypotheses stated in terms of fold changes are more convenient than hypotheses stated in terms of
differences. This is because ratios can be interpreted as percentages, but differences must be interpreted as actual
amounts in their original scale. Hence, it has become a common practice to take the following steps in hypothesis
testing.
1. State the statistical hypotheses in terms of the fold change (ratio) of the means.
2. Transform this into hypotheses about a difference by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in terms of the ratio.
Thus, a hypothesis about the fold change of the means on the original scale can be translated into a hypothesis
about the difference of two means on the logged scale.

Coefficient of Variation
The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter can be used
to represent the variation in the data because of a unique relationship that it has in the case of log-normal data.
Suppose the variable X is the logarithm of the original variable Y. That is, X = ln(Y) and Y = exp(X). Label the
mean and variance of X as µ X and σ X2 , respectively. Similarly, label the mean and variance of Y as µY and σ Y2 ,
respectively. If X is normally distributed, then Y is log-normally distributed. Julious (2004) presents the following
well-known relationships between these two variables

 µX +σ X 
2 
µY =  e



2

(

)

σ Y2 = µY2 eσ − 1
2
X

From this relationship, the coefficient of variation of Y can be found to be

(

)

µY2 eσ − 1

COVY =

2
X

µY

= eσ X − 1
2

Solving this relationship for σ X2 , the standard deviation of X can be stated in terms of the coefficient of variation
of Y. This equation is

σ X = ln(COVY2 + 1)
Similarly, the mean of X is

µX =

(

µY

)

ln COVY2 + 1

One final note: for parallel-group designs, σ X2 is the pooled standard deviation of the logged data. Thus, the
hypotheses can be stated in the original (Y) scale and the power can be calculated in the transformed (X) scale.
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Power Calculation
As is shown above, the hypotheses can be stated in the original (Y) scale using ratios or the logged (X) scale
using differences. In either case, power and sample size calculations are made using the formulas for testing the
difference in two means. These formulas are presented in another chapter and are not duplicated here.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the ratios, sample sizes, alpha, and power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. In most situations, you will select
either Power or Sample Size.

Test
Alternative Hypothesis
This option specifies the alternative hypothesis. This implicitly specifies the direction of the hypothesis test.
Possible selections are:
•

H1: FC1 ≠ FC0
This is the most common selection. It yields the two-tailed t-test. Use this option when you are testing
whether the means are different, but you do not want to specify beforehand which mean is larger.

•

H1: FC1 < FC0
This option yields a one-tailed t-test. Use it when you are only interested in the case in which Mean1 is
greater than Mean2.

•

H1: FC1 > FC0
This option yields a one-tailed t-test. Use it when you are only interested in the case in which Mean1 is less
than Mean2.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal means when in fact the means are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
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N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size – Fold Changes
FC0 (Fold Change | H0)
This is the value of the fold change assumed by the null hypothesis, H0. Usually, FC0 = 1.0 which implies that the
two means are equal. However, you may test other values of FC0 as well. Strictly speaking, any positive number
is valid, but values near to, or equal to, 1.0 are usually used.
Warning: you cannot use the same value for both FC0 and FC1.
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FC1 (Fold Change | H1)
This is the value of the fold change of the two means at which the power is to be calculated. Often, a range of
values will be tried. For example, you might try the four values:
1.25 1.5 1.75 2.0
Strictly speaking, any positive number is valid. However, numbers between 0.25 and 4.00 are usually used.
Warning: you cannot use the same value for both FC0 and FC1.

Effect Size – Coefficient of Variation
COV (Coefficient of Variation)
A response variable Y has mean μY and standard deviation σY. The coefficient of variation of Y, σY/μY, is used to
specify the variation in Y.
Suppose that Y is skewed, so a logarithmic transformation will be applied. That is, the variable X = Ln(Y) will be
analyzed using an appropriate ANOVA procedure. The analysis assumes that X is normally distributed with mean
μX and standard deviation σX. So Y is lognormal and X is normal. Power and sample size calculations are made on
X. However, interpretation may be easier in the Y scale.
If Y is truly lognormal, there is a direct relationship between μY and σY and μX and σX. Using this relationship, it
can be shown that

Solving for σX, we obtain

𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌 = �𝐸𝐸𝐸𝐸𝐸𝐸(𝜎𝜎𝑋𝑋2 ) − 1
𝜎𝜎𝑋𝑋 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1)

There are two ways to obtain a value for COVY.

1. Calculate COVY directly from the mean and SD of a set of Y values obtained from a previous (or pilot) study.
2. For parallel-group designs, use σ X2 to estimate COV of Y using the formula above. Here σ X2 is given by σ d2 ,
the average variance used in the t-test of the logged data.
We have found that method 1 does not provide a reliable estimate of σX, so we recommend method 2.
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Example 1 – Finding Power
A company has developed a generic drug for treating rheumatism and wants to show that it is better than the
standard drug. From previous studies, responses for either treatment are known to follow a lognormal distribution.
A parallel-group design will be used and the logged data will be analyzed with a one-sided, two-sample t-test.
Past experience leads the researchers to set the COV to 1.20. The significance level is 0.025. The power will be
computed for R1 equal 1.10 and 1.20. Sample sizes between 100 and 900 will be examined in the analysis.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Fold Change of Two Means procedure window by expanding Means, then Two
Independent Means, then clicking on Ratio Test, and then clicking on Tests for Fold Change of Two Means.
You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ FC1 > FC0 (One-Sided)
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 100 to 900 by 200
FC0 (Fold Change | H0) ......................... 1.0
FC1 (Fold Change | H1) ......................... 1.1 1.2
COV (Coefficient of Variation) ................ 1.2

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing the Fold Change using a Two-Sample T-Test
H0: FC1 = FC0. H1: FC1 > FC0.
Power
0.1057
0.2339
0.3581
0.4715
0.5718
0.2737
0.6556
0.8625
0.9506
0.9836

N1
100
300
500
700
900
100
300
500
700
900

N2
100
300
500
700
900
100
300
500
700
900

N
200
600
1000
1400
1800
200
600
1000
1400
1800

FC0
1.000
1.000
1.000
1.000
1.000
1.000
1.000
1.000
1.000
1.000

FC1
1.100
1.100
1.100
1.100
1.100
1.200
1.200
1.200
1.200
1.200

Effect
Size
0.1009
0.1009
0.1009
0.1009
0.1009
0.1930
0.1930
0.1930
0.1930
0.1930

COV
1.2
1.2
1.2
1.2
1.2
1.2
1.2
1.2
1.2
1.2

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025

References
Chow, S.C.; Shao, J.; Wang, H. 2003. Sample Size Calculations in Clinical Research. Marcel Dekker. New York.
Julious, Steven A. 2004. 'Tutorial in Biostatistics. Sample sizes for clinical trials with Normal data.'
Statistics in Medicine, 23:1921-1986.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
FC0 is the fold change (ratio) under the null hypothesis, H0. FC1 is the fold change at which the power is
calculated.
The effect size is |ln(FC0)-ln(FC1)| / (sigma).
COV is the coefficient of variation on the original scale. The value of sigma is calculated from this.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
A one-sided, two-sample t-test with group sample sizes of 100 and 100 achieves 11% power to
detect a fold change of 1.100 when the fold change under the null hypothesis is 1.000. The
coefficent of variation on the original scale is 1.2. The significance level (alpha) is 0.025.

This report shows the power for the indicated scenarios.

Plots Section

These plots show the relationship of power to sample size for the two values of FC1.
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Example 2 – Validation
We will validate this procedure by showing that it gives the identical results to the regular test on differences—a
procedure that has been validated. We will use the same settings as those given in Example 1. Since the output for
this example is shown above, only the output from the procedure that uses differences is shown below.
To run the power analysis of a t-test on differences, we need the values of Mean2 (which correspond to R1) and
S1. The value of Mean1 will be zero.

(
.
ln(12

)

S1 = ln COV 2 + 1
=

2

)

+1

= 0.944456

Mean2 = ln( R1)

Mean2 = ln( R1)

. )
= ln(110

= ln(120
. )

= 0.095310

= 0182322
.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Two-Sample T-Tests Assuming Equal Variance (Enter Means) procedure window by
expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on TwoSample T-Tests Assuming Equal Variance (Enter Means). You may then make the appropriate entries as listed
below, or open Example 7 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Ha: µ1 < µ2
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 100 to 900 by 200
µ1 ............................................................ 0
µ2 ............................................................ 0.095310 0.182322
σ .............................................................. 0.944456
Reports Tab
Means Decimals ..................................... 6
Plot Text Tab
Means Decimals ..................................... 6
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample T-Test Assuming Equal Variance
Alternative Hypothesis: μ1 < μ2
Power
0.10568
0.23392
0.35811
0.47145
0.57180
0.27374
0.65562
0.86253
0.95061
0.98359

N1
100
300
500
700
900
100
300
500
700
900

N2
100
300
500
700
900
100
300
500
700
900

N
200
600
1000
1400
1800
200
600
1000
1400
1800

μ1
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000

μ2
0.095310
0.095310
0.095310
0.095310
0.095310
0.182322
0.182322
0.182322
0.182322
0.182322

μ1 - μ2
-0.095310
-0.095310
-0.095310
-0.095310
-0.095310
-0.182322
-0.182322
-0.182322
-0.182322
-0.182322

σ
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9
0.9

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025

You can compare these power values with those shown above in Example 1 to validate the procedure. You will
find that the power values are identical.
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